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GETTING STARTED GUIDE

NI PXI-5660
This guide explains how to install, configure, test, and begin using an NI PXI-5660 radio frequency (RF) 

vector signal analyzer, and introduces programming methods and examples. Refer to the 1. Verifying 

System Requirements section for information about additional documents.

Contents

Conventions ......................................................................................................................................... 1

1. Verifying System Requirements ...................................................................................................... 2

2. Unpacking........................................................................................................................................ 2

3. Verifying Kit Contents..................................................................................................................... 3

Other Required Items................................................................................................................... 3

4. Installing the Software ..................................................................................................................... 5

5. Installing the NI 5660 ...................................................................................................................... 6

Installing the NI 5600 RF Downconverter Module ..................................................................... 6

Installing the NI 5620 IF Digitizer Module ................................................................................. 7

Installing PXI Modules................................................................................................................ 7

Uninstalling PXI Modules ........................................................................................................... 8

6. Interconnecting the NI 5660 Modules ............................................................................................. 8

Cooling Considerations................................................................................................................ 10

7. Configuring and Programming the NI 5660 .................................................................................... 10

Rename Both Modules................................................................................................................. 11

Acquiring Data Interactively ....................................................................................................... 11

Configuring Hardware Programmatically ................................................................................... 14

Introduction to the Spectral Measurements Toolkit .................................................................... 17

Appendix A: Hardware Front Panel Connectors and Indicators ......................................................... 17

NI 5600 RF Downconverter Module ........................................................................................... 18

NI 5620 IF Digitizer Module ....................................................................................................... 20

Appendix B: Troubleshooting ............................................................................................................. 21

Installation ................................................................................................................................... 21

Configuration ............................................................................................................................... 23

Measurements .............................................................................................................................. 24

Technical Support and Professional Services...................................................................................... 24

Conventions

The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box options to a final action. 

The sequence File»Page Setup»Options directs you to pull down the File menu, select the 

Page Setup item, and select Options from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.
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This icon denotes a caution, which advises you of precautions to take to avoid injury, data loss, 

or a system crash. When this symbol is marked on a product, refer to the Read Me First: Safety 

and Electromagnetic Compatibility for information about precautions to take.

When symbol is marked on a product, it denotes a warning advising you to take precautions 

to avoid electrical shock. 

When symbol is marked on a product, it denotes a component that may be hot. Touching this 

component may result in bodily injury.

bold Bold text denotes items that you must select or click in the software, such as menu items and 

dialog box options. Bold text also denotes parameter names.

italic Italic text denotes variables, emphasis, a cross-reference, or an introduction to a key concept. 

Italic text also denotes text that is a placeholder for a word or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the keyboard, sections 

of code, programming examples, and syntax examples. This font is also used for the proper 

names of disk drives, paths, directories, programs, subprograms, subroutines, device names, 

functions, operations, variables, filenames, and extensions.

monospace Italic text in this font denotes text that is a placeholder for a word or value that you must

italic supply.

Platform Text in this font denotes a specific platform and indicates that the text following it 
applies only to that platform.

1. Verifying System Requirements

Your system must meet certain requirements to use NI RF vector signal analyzers. For more information 

about minimum system, recommended system, and supported application development environments 

(ADEs), refer to the NI RF Signal Analyzers Readme, which is available with the NI-RFSA software. 

Note After you install NI-RFSA, you can access the NI RF Signal Analyzers Readme at Start»

All Programs»National Instruments»NI-RFSA»Documentation or online at ni.com/

downloads.

2. Unpacking

RF vector signal analyzer hardware modules ship in antistatic packages to prevent damage from 

electrostatic discharge (ESD). Because ESD can damage several components of the hardware modules, 

store all modules in the antistatic envelopes when not in use.

Caution Never touch exposed connector pins.

To avoid damage when handling the RF vector signal analyzer hardware modules, take the following 

precautions:

• Ground yourself using a grounding strap or by touching a grounded object.

• Touch the antistatic package to a metal part of your computer chassis before removing the hardware 

module from the package.

Remove each hardware module from the package and inspect it for loose components or any signs of 

damage. Notify NI if any hardware module appears damaged in any way. Do not install a damaged 

module into your system.
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3. Verifying Kit Contents

You need the following items to set up and use the RF vector signal analyzer. Listboxes represent 

physical kit items. 

❑ Driver software disc—Installs the NI-RFSA and ni5660 instrument driver software and electronic 

documentation, including the following documents:

– NI RF Signal Analyzers Readme—This HTML document includes information about the 

minimal and recommended system requirements, new features, installed file locations, and 

uninstalling/modifying the NI-RFSA instrument driver software.

– NI PXI-5660 Help—Use this online help file, located at Start»All Programs»

National Instruments»NI-RFSA»Documentation, to learn how to operate NI 5660 RF 

vector signal analyzers.

– NI High-Speed Digitizers Help—Use this online help document, located at Start»All 

Programs»National Instruments»NI-SCOPE»Documentation, to learn more information 

about the IF digitizer module included as part of your RF vector signal analyzer.

– NI-Tuner Help—Use this online help document, located in the Program Files»National 

Instruments»<LabVIEW>»Help directory, for full access to the functionality of the 

instrument drivers for the RF downconverter and IF digitizer modules.

❑ NI Spectral Measurement Toolkit CD—Installs the Spectral Measurements Toolkit (SMT) 

software components, which includes SMT VIs and functions, examples, and documentation.

❑ 1/8 in. combination Phillips/flathead screwdriver

❑ The following printed documentation:

– NI 5660 Getting Started Guide (this document)

– Specifications documents for your device

– Read Me First: Safety and Electromagnetic Compatibility

– Maintain Forced-Air Cooling Note to Users

❑ Two hardware modules:

– NI 5600 RF downconverter module

– NI 5620 IF digitizer module

❑ Short cables for interconnecting modules

– One short, semi-rigid SMA-to-SMA coaxial cable

– One long, semi-rigid SMA-to-SMA coaxial cable

– One semi-flexible SMA-to-SMA coaxial cable

❑ Plastic collars (cable wrenches) for gripping the coaxial cable hex connectors

Other Required Items

❑ One of the following configurations:

– (PXI system) A PXI chassis, PXI embedded or MXI controller system that meets the system 

requirements specified in this guide, and chassis documentation.

– (PXI Express system) A PXI Express chassis, PXI Express embedded or MXI Express 

controller, and chassis documentation.

❑ A 1 N · m standard SMA torque wrench (part number 187106-01), for use with included SMA 

driver bit
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Figure 1.  NI 5660 Kit Contents and Replacement Part Numbers

4. Installing the Software

Complete the following steps to install the components of the instrument driver software. You must 

install all of the included software before installing any RF vector signal analyzer hardware.

1. Install an application development environment (ADE) such as LabVIEW, LabWindows™/CVI™, 

or a third-party program according to its instructions. Any development environment you intend to 

use must be installed before you install the driver software and the Spectral Measurements Toolkit.

1 NI PXI-1042 or NI PXI-1045 Chassis (not included)
2 NI 5600 RF Downconverter Module
3 NI 5620 IF Digitizer Module
4 Short, Semi-Rigid SMA-to-SMA Cable, 763480-01

5 Long, Semi-Rigid SMA-to-SMA Cable, 763481-01
6 Semi-Flexible SMA-to-SMA Cable, 763488-01
7 Cable Wrenches (2), 746016-01
8 Screwdriver, 772006-01

4 5 6

1

NI PXI-1042

87

2

NI 5600

POWER

STATUS

RF DOWNCONVERTER

+20 dBm MAX

+30 dBm MAX
WITH ATTN
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2. Insert the NI-RFSA disc into the appropriate drive and follow the instructions in the installation 

window. You can choose to install NI-RFSA 2.1 (NI PXI-5661 and NI PXIe-5663) and/or 

NI PXI-5660 Support.

(Windows Vista) Users may see access and security messages during installation. Accept the 

prompts to complete the installation. 

Note If the installation window. does not appear, navigate to the appropriate disk drive, and 

double-click setup.exe. 

3. If you are using a system running the LabVIEW Real-Time Module, download NI-RFSA to the 

target using Measurement & Automation Explorer (MAX). Refer to the MAX Remote Systems Help 

by selecting Help»Help Topics»Remote Systems in MAX for more information about using 

MAX remote systems.

4. When installation completes, remove the driver software disc.

Note You must install the driver software before installing the Spectral Measurements Toolkit.

5. Insert the Spectral Measurements Toolkit CD. 

6. Install the Spectral Measurements Toolkit for the ADE you intend to use. Follow instructions in the 

installation window.

7. When the installation completes, remove the Spectral Measurements Toolkit CD.

Note For full functionality, you must install the Spectral Measurements Toolkit packaged with the 

RF vector signal analyzer. The Spectral Measurements Toolkit extends the capability of the RF vector 

signal analyzer to include frequency- and modulation-domain measurements and analysis of 

analog-modulated IF signals.

8. Install any additional software that you intend to use with the RF vector signal analyzer after 

installing the driver software and the Spectral Measurements Toolkit.

Note If toolkits or other software that you intend to use with the RF device were installed before 

you installed the driver software, repeat or repair those installations after installing the driver 

software and the Spectral Measurements Toolkit.

Note The Spectral Measurements Toolkit includes examples for analog modulation and 

demodulation. The Modulation Toolkit includes digital modulation and demodulation measurement 

functions. Both toolkits may be included in your RF vector signal analyzer shipping kit. You can also 

purchase and install the NI Modulation Toolkit at ni.com. Install NI PXI-5660 Support and the 

Spectral Measurements Toolkit before installing the Modulation Toolkit.

5. Installing the NI 5660

The NI 5660 modules are available in the PXI form factor. Installation of the NI 5660 RF vector signal 

analyzer hardware modules requires four vacant PXI (or hybrid) slots—three slots for the NI 5600 RF 

downconverter module and one slot for the NI 5620 IF digitizer module. The NI 5620 must be installed 

in the slot immediately to the right of the NI 5600 to allow for the use of the included coaxial cables.

Note You must install NI PXI-5660 Support before installing the hardware.

Installing the NI 5600 RF Downconverter Module
To install the NI 5600 module, complete steps 1 through 10 in the Installing PXI Modules section. 

Note The NI 5600 onboard frequency reference can drive the PXI backplane clock only if the 

RF downconverter module is installed in PXI Slot 2. When the NI 5600 is installed in PXI Slot 2, you 

can configure it to lock the PXI backplane clock to the highly accurate and stable NI 5600 onboard 
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oven-controlled crystal oscillator (OCXO). You can also lock the NI 5600 to an external frequency 

reference clock signal and drive this reference to the backplane. To use an external frequency 

reference, you must connect this signal to the FREQ REF IN connector on the NI 5600 module front 

panel.

Installing the NI 5620 IF Digitizer Module
To install the NI 5620 module, complete steps 2 through 11 in the Installing PXI Modules section.

Installing PXI Modules
NI PXI modules are sensitive instruments that should be handled carefully. Do not expose the module 

to temperatures or humidity beyond the rated maximums.

Note For information about the rated maximums, refer to your device specifications document, 

located at Start»All Programs»National Instruments»NI-RFSA»Documentation»

Specifications.

Keep the module free of dust by cleaning only with compressed air. Do not clean the device with any 

solvents or liquids.

To prevent damage to the device caused by ESD or contamination, handle the device using the edges or 

the metal bracket. For more information about the radio-frequency interference characteristics of your 

hardware, refer to the Read Me First: Safety and Electromagnetic Compatibility document.

Caution You must power off and unplug the chassis before installing the device.

You can install PXI modules in any PXI slot marked with a peripheral slot compatibility 

glyph (a circle containing the slot number).

You also can install PXI modules in any PXI hybrid slot marked with a peripheral slot 

compatibility glyph (the letter “H” and a solid circle containing the slot number).

Install a PXI module by completing the following steps:

1. Power off and unplug your PXI chassis.

2. If the chassis has multiple fan speed settings, ensure that the fans are at the highest setting. Do not 

set the fan speed to low or turn the fan off.

3. Position the chassis so that you allow ample space between the chassis fan intake and exhaust vents. 

Blockage by walls or obstructions affects the air flow needed for cooling. Refer to the chassis 

documentation for more information about cooling.

4. Make sure the ejector handle is in the unlatched (downward) position.

5. Remove the rubber screw covers from the captive screws in the module front panel.

6. Holding the module by the ejector handle, slide it into an available PXI (or hybrid) slot, as shown 

in Figure 2. Ensure that the base card (the card on the left when looking at the front of the module) 

engages with card guides in the chassis.

7. Slide the module completely into the chassis and latch by pulling up on the ejector handle.

8. Tighten the screws in the module front panel. Performance may suffer if the screws are not 

tightened properly.

9. Verify that the PXI chassis fans are operable and free of dust and other contaminants that may 

restrict airflow.

3

7

H
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10. Install all chassis covers and filler panels after installing the RF vector signal analyzer hardware 

modules. Missing filler panels disrupt necessary air circulation in the chassis.

Note NI recommends installing slot blockers in adjacent vacant PXI slots to maximize cooling air 

flow to the RF vector signal analyzer hardware modules. The PXI Chassis Slot Blocker Kit (part 

number 778678-01) is available for purchase at ni.com.

11. Plug in and power on the PXI chassis.

Figure 2 shows the correct installation of a PXI module into a compatible chassis slot.

 

Figure 2.  PXI Module Installation

Uninstalling PXI Modules
Power off the chassis prior to removing PXI modules. When removing PXI modules from the chassis, 

ensure that you are grounded with a grounding strap or are touching a grounded metal surface. To avoid 

ESD, do not touch the exposed connector pins or any exposed circuitry on the device. When not in use, 

PXI devices should be stored in the original antistatic envelope to avoid damage.

Hot Surface During operation, the metal surfaces of PXI devices may become hot. Be careful when 

removing the device from the chassis or when moving it to a different peripheral slot. When removing 

the device, hold it by only the ejector handle and front panel.

6. Interconnecting the NI 5660 Modules

The NI 5600 and NI 5620 interconnect through the module front panels. Complete steps 1 through 6 

to interconnect the RF vector signal analyzer hardware module front panel connectors, as shown in 

Figure 3.

1 PXI Chassis
2 Ejector Handle Unlatched
3 Captive Screws with Rubber Screw Covers Removed
4 NI PXI Module

3

2

4
NI PXI-1042

1
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Figure 3.  Interconnection of Devices with Included NI 5660 Cables

Note The published specifications document for your NI 5660 RF vector signal analyzer assumes 

use of the included cables. Substituting different cables may affect performance.

1. Using the short semi-rigid coaxial cable, connect the OUTPUT connector on the NI 5600 RF 

downconverter front panel to the INPUT connector on the NI 5620 IF digitizer front panel.

Note The semi-rigid cables must be installed so the bends point upwards, as shown in Figure 3.

2. Using the long semi-rigid coaxial cable, connect the lower of the two 10 MHz OUT connectors on 

the NI 5600 front panel to the REF CLK IN connector on the NI 5620 front panel.

Note The NI 5600 onboard frequency reference can drive the PXI backplane clock only if the 

RF downconverter module is installed in PXI Slot 2. When the NI 5600 is installed in PXI Slot 2, you 

can configure it to lock the PXI backplane clock to the highly accurate and stable NI 5600 onboard 

oven-controlled crystal oscillator (OCXO). You can also lock the NI 5600 to an external frequency 

FREQ. REF IN
50 Ω

+16 dBm MAX
±5V DC MAX

10 MHz OUT
1 V pp 50 Ω

PXI 10 MHz I/O
50 Ω

+23 dBm MAX
± 5 V DC MAX INPUT

50 Ω
0 V DC MAX

50 Ω
+16 dBm MAX

50 Ω
+20 dBm MAXOUTPUT

50 Ω
5 MHz - 25 MHz

INPUT

REF CLK IN

PFI 1

NI 5600 NI 5620
64 MS/s Digitizer

POWER

STATUS

RF DOWNCONVERTER

+20 dBm MAX
+30 dBm MAX

WITH ATTN
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reference clock signal and drive this reference to the backplane. To use an external frequency 

reference, you must connect this signal to the FREQ REF IN connector on the NI 5600 module front 

panel.

3. (Optional) Using the semi-flexible coaxial cable, connect the bidirectional PXI 10 MHz I/O 

connector on the NI 5600 front panel to the upper 10 MHz OUT connector on the NI 5600 front 

panel.

Caution Incorrect torque at SMA connections can degrade signal fidelity, phase-locked loop (PLL) 

performance, and insertion loss. Use an SMA torque wrench to ensure all SMA connections are 

properly torqued to 1 N · m.

4. Carefully tighten all SMA connectors to 1 N · m using an SMA torque wrench (not included), as 

shown in Figure 3. Tighten only until the wrench clicks.

5. Plug in and power on your PXI chassis and controller system.

6. Verify that the POWER LED on the NI 5600 RF downconverter module is illuminated. If the LED 

is not illuminated, refer to Appendix B: Troubleshooting.

You have completed installation of your NI 5660 RF vector signal analyzer.

Cooling Considerations
When installing a PXI module, follow the guidelines in the Maintain Forced-Air Cooling Note to Users 

document included in the kit to ensure that the device is cooled effectively.

Caution Inadequate air circulation could cause the temperature inside the chassis to rise above the 

optimal operating temperature for the RF vector signal analyzer hardware modules, potentially 

causing thermal shutdown, shorter life spans, or improper performance.

7. Configuring and Programming the NI 5660

Use Measurement & Automation Explorer (MAX) to configure your National Instruments hardware. 

MAX informs other programs about which devices reside in the system and how they are configured. 

MAX is automatically installed with the driver software.

To use MAX to configure, self-test, and functionally test the NI 5660 RF vector signal analyzer 

hardware modules, complete the following steps:

1. Launch MAX by navigating to Start»All Programs»National Instruments»Measurement & 

Automation or by clicking the MAX desktop icon.

2. In the Configuration pane, double-click Devices and Interfaces to see the list of installed devices.

3. Expand the Traditional NI-DAQ (Legacy) Devices folder. You will see a list of installed devices 

that includes the NI 5600 and NI 5620 modules (your default device names may vary).

Note If you do not see the NI 5600 and NI 5620 modules listed, refer to Appendix B: 

Troubleshooting.

4. Note the device numbers assigned to your RF vector signal analyzer hardware modules by MAX. 

These numbers are used when programming the RF vector signal analyzer.

Complete steps 5 through 11 to self-test both modules.

5. Right-click NI PXI-5600 and select Properties.

6. The Configuring Device dialog box appears. Click Test Resources to self-test the NI 5600 RF 

downconverter hardware module. The MAX self-test performs a basic verification of hardware 

resources.
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7. The NI-DAQ Configuration Utility dialog box appears to confirm your self-test. Click OK to return 

to the Configuring Device dialog box.

Note If the NI 5600 RF downconverter module fails the self-test, refer to Appendix B: 

Troubleshooting.

8. In the NI 5600 Configuring Devices dialog box, click OK to return to MAX.

9. Right-click NI PXI-5620 and select Properties.

10. The Configuring Device dialog box appears. Click Test Resources to self-test the NI 5620 IF 

digitizer hardware module.

11. The NI-DAQ Configuration Utility dialog box appears. Click OK to return to the Configuring 

Device dialog box and continue with the NI 5620 test panel.

Note If the NI 5620 IF digitizer module fails the self-test, refer to Appendix B: Troubleshooting.

You have completed setup, configuration, and testing of the NI 5660 RF vector signal analyzer.

Rename Both Modules
MAX allows you to rename both NI 5660 hardware modules. The MAX name is used in software to 

operate the NI 5660 hardware resources. You are not required to change the module names from the 

default names assigned by MAX, but doing so can make your program more readable. If you do not wish 

to rename the modules, proceed to the Acquiring Data Interactively section.

To rename both NI 5660 hardware modules, complete steps 1 through 7.

1. Right-click NI PXI-5600 and select Rename from the shortcut menu.

2. Enter the new name for the NI 5600 module.

Note The device name must consist only of alphanumeric and underscore characters.

3. Click OK.

4. Right-click NI PXI-5620 and select Rename from the shortcut menu.

5. Enter the new name for the NI 5620 module.

6. Click OK.

7. Verify that the new names for both modules are displayed before proceeding to the next section.

Acquiring Data Interactively
To interactively acquire data and perform measurements with the RF vector signal analyzer, use the 

included RFSA Demo Panel. The RFSA Demo Panel is accessible from within MAX at Tools»

Soft Front Panels»NI5660 - RFSA Demo Panel and from the Start menu at Start»All Programs»

National Instruments»NI-RFSA»5660 Demo Panel.

Tip If an external signal source is not available, the signal from the 10 MHz OUT connector on the 

NI 5600 RF downconverter module front panel can be used as a source to verify proper RF vector 

signal analyzer installation and as a live signal for the RFSA Demo Panel. To use this signal, connect 

the 10 MHz OUT connector of the NI 5600 module to the INPUT connector on the NI 5600 RF 

downconverter module front panel.

The RFSA Demo Panel (shown in Figure 4) provides a convenient software interface with which 

you can operate the RF vector signal analyzer hardware to perform common frequency-domain and 

I/Q measurements. 

Tip Press <Ctrl-H> to view context-sensitive help for all RFSA Demo Panel controls and indicators.
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Figure 4.  RFSA Demo Panel Performing ACP Measurement

To use the RFSA Demo Panel, configure the following controls:

1. Verify that the device numbers in the RFSADeviceNumbers dialog box reflect those assigned to 

the RF vector signal analyzer hardware modules in MAX, and click OK. 

2. Specify hardware parameters for your measurement, including the following parameters, in 

Hardware Settings:

• RF Spectrum Settings

• Amplitude

• Timing

• Advanced Spectral Parameters

• Devices

1 Measurements Controls
2 Hardware Settings Controls

3 Averaging Controls
4 Units Controls

5 Waveform Graph

1

2

5

34
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3. Specify the measurement you want to perform in Measurements. Choose one of the following 

options:

• Peak Search

• Delta Peak

• Power in Band

• Adjacent Channel Power (ACP)

• Occupied Bandwidth

• IQ Data

4. Specify averaging applied to returned data in Averaging Type. Figure 5 illustrates the hierarchy 

of options for spectrum averaging.

Figure 5.  RFSA Demo Panel Spectrum Averaging Options

5. Specify units in which to return measurement results in Units. Several commonly used units are 

available.

Exponential

Average Size

Peak-HoldNo Averaging VectorRMS
Averaging 

Type

Linear
Weighting 

Type

Linear 

Weighting 

Mode

Moving AverageAuto Restart ContinuousOne Shot
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Configuring Hardware Programmatically
Two paradigms are available to programmatically configure the NI 5660 RF vector signal analyzer 

hardware for data acquisition, as shown in Table 1.

Note The NI Spectral Measurements Toolkit is used to perform measurements on the acquired data 

regardless of programming paradigm.

Programming the RF Vector Signal Analyzer in LabVIEW

To programmatically configure the RF vector signal analyzer hardware for data acquisition in 

LabVIEW, use the ni5660 VIs. These VIs control both the NI 5600 RF downconverter module and 

the NI 5620 IF digitizer module as a single instrument for frequency-domain and I/Q data acquisitions. 

The ni5660 VIs are located on the LabVIEW function palette at Instrument I/O»Instrument Drivers»

ni5660. 

ni5660 LabVIEW VIs Programming Flow

The ni5660 VIs use two programming flows: a frequency-domain acquisition programming flow and 

an I/Q acquisition programming flow. Every application built using the ni5660 VIs must call the 

ni5660 Initialize VI and the ni5660 Close VI.

Frequency-Domain Measurements Programming Flow

Use the programming flow shown in Figure 6 to acquire data and perform frequency-domain 

measurements using the ni5660 VIs. Use the ni5660 Configure for Spectrum VI and the ni5660 Read 

Averaged Power Spectrum VI when Acquiring a Frequency Spectrum.

Table 1.   Programmatic Configuration Paradigms for RF Vector Signal Analyzer Hardware

Programming 

Paradigm Benefits ADE Support

ni5660 VIs Ease of use from a higher-level application 

programming interface: both RF vector signal analyzer 

hardware modules are controlled as a single instrument

Addresses common frequency-domain and 

I/Q measurement applications

Refer to the NI RF 

Signal Analyzers 

Readme

Spectral Measurements 

Toolkit;

NI-SCOPE and 

NI-TUNER drivers

Maximum flexibility for unique applications from a 

lower-level application programming interface

Provides full access to functionality of the instrument 

drivers for the RF downconverter and IF digitizer 

modules

Refer to the NI RF 

Signal Analyzers 

Readme
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Figure 6.  Acquiring a Frequency Spectrum

I/Q Acquisition Programming Flow

Use the programming flow shown in Figure 7 and Figure 8 to acquire I/Q data in single-shot or 

continuous modes, respectively. Use the ni5660 Configure for IQ Settings VI and the ni5660 Read IQ 

VI when Acquiring Single-Shot I/Q Data. Use the ni5660 Configure for IQ Settings VI, the ni5660 

Initiate IQ VI, and the ni5660 Fetch IQ VI when Acquiring Continuous I/Q Data.

Figure 7.  Acquiring Single-Shot I/Q Data

Figure 8.  Acquiring Continuous I/Q Data

Example Applications for LabVIEW

Several example ni5660 VI applications are available for LabVIEW. These examples are intended to 

serve as interactive tools, programming models, and building blocks in your applications.

All installed ni5660 example files are located in the location specified in the NI RF Signal Analyzers 

Readme.

LabVIEW examples demonstrate integration of the NI RF vector signal analyzer with 

NI RF signal generators and NI toolkit software, including the Modulation Toolkit. Refer to the 

NI Developer Zone on the Web at ni.com/examples for these examples and more information.
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Programming the RF Vector Signal Analyzer in LabWindows/CVI and C

With LabWindows/CVI and C you can program the RF vector signal analyzer hardware modules 

individually, using function calls to the Spectral Measurements Toolkit and the individual drivers for the 

RF downconverter and IF digitizer modules. The following list describes the role of each program: 

• The Spectral Measurements Toolkit contains specialized functions for programming the RF vector 

signal analyzer hardware for frequency-domain and I/Q measurements.

• The NI-SCOPE instrument driver controls the NI 5620 IF digitizer module and triggering of the 

RF vector signal analyzer. 

• For more information about NI-SCOPE and triggering, refer to the NI High-Speed Digitizers Help, 

located at Start»All Programs» National Instruments»NI-SCOPE»Documentation.

• The NI-TUNER driver controls the NI 5600 RF downconverter module. 

For more information about NI-TUNER, refer to the NI-TUNER Help, located at Start»

All Programs»National Instruments» NI-TUNER»Documentation.

The NI-SCOPE and NI-TUNER software components are depicted in Figure 9.

Figure 9.  Software Flow Diagram for LabWindows/CVI and C

Note When programmatically operating the RF vector signal analyzer hardware, specify the 

NI 5620 IF digitizer module using the DAQ Resource Name with the following syntax:

DAQ::DeviceNumber

Specify the NI 5600 RF downconverter module using the MAX device number without modifiers.

User Application

SMT

NI-TUNER

NI 5600

Hardware

NI-SCOPE

NI 5620

Hardware
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Introduction to the Spectral Measurements Toolkit
NI provides add-on software toolkits, such as the Spectral Measurements Toolkit (included) and the 

Modulation Toolkit, that extend the capability of the RF vector signal analyzer to include frequency- and 

modulation-domain measurements, and analysis of analog-modulated IF signals. 

Note You must install the Spectral Measurements Toolkit CD packaged with your RF vector signal 

analyzer. The Spectral Measurements Toolkit is necessary for analysis of modulated signals using the 

RF vector signal analyzer.

Use the Spectral Measurements Toolkit (SMT) VIs and functions for frequency-domain analysis, 

measurement, and display of data acquired using the RF vector signal analyzer. The SMT can perform 

several operations, including the following:

• Zoom Fast Fourier Transform (FFT) processing and spectrum averaging

• Spectral measurements such as band power, adjacent channel power, and peak frequency and 

magnitude

• Spectrogram display and analysis

• RF vector signal analyzer hardware configuration for frequency-domain measurements

For complete information about SMT VIs and functions, refer to the Spectral Measurements Toolkit 

documentation, accessible from Start»All Programs»National Instruments»Spectral 

Measurements. For more information about the Modulation Toolkit, refer to ni.com/rf/

software.

SMT Example Applications for LabWindows/CVI and C

The Spectral Measurements Toolkit includes LabWindows/CVI and C examples for the RF vector signal 

analyzer hardware. You can access the Spectral Measurements Toolkit examples at Start»

All Programs»National Instruments»Spectral Measurements»CVI Support. The example files 

are in the location specified in the NI RF Signal Analyzers Readme.

Appendix A: Hardware Front Panel Connectors and Indicators

The following sections describe the connectors and LED indicators on the front panels of all three RF 

vector signal analyzer hardware modules. All input and output terminals, except the PFI 1 connector on 

the NI 5622 IF digitizer front panel, are AC-coupled.

Note Refer to Figure 3, Interconnection of Devices with Included NI 5660 Cables, for illustrations 

of standard RF vector signal analyzer hardware module front panel interconnections.
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NI 5600 RF Downconverter Module
The NI 5600 RF downconverter module front panel contains six connectors and two LEDs, as shown in 

Figure 10.

Figure 10.  NI 5600 RF Downconverter Module Front Panel

Note The PXI 10 MHz I/O connector can be used to route reference clock signals to the PXI 

backplane only when the NI 5600 RF downconverter module is installed in PXI Slot 2. This 

connector can export the PXI 10 MHz backplane clock from any NI 5600 PXI installation slot. 

For more information about exporting reference clock signals, refer to the NI PXI-5660 Help.

INPUT
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0 V DC MAX

OUTPUT
50 Ω

5 MHz - 25 MHz

+20 dBm MAX
+30 dBm MAX

WITH ATTN

PXI 10 MHz I/O
50 Ω

+23 dBm MAX
± 5 V DC MAX

10 MHz OUT
1 V pp 50 Ω

FREQ. REF IN
50 Ω

+16 dBm MAX
±5 V DC MAX

NI 5600

POWER

STATUS

RF DOWNCONVERTER
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Table 2.  NI 5600 RF Downconverter Module Front Panel Connectors

Connector Use

FREQ REF IN Routes an external frequency reference signal to which the NI 5600 can lock. This signal 

can be propagated to the PXI backplane when the NI 5600 is installed in PXI Slot 2.

10 MHz OUT Generate replications of the downconverter 10 MHz frequency reference signal. These 

replicated signals are also useful for driving other devices. Each replication is 180 

degrees out-of-phase with the other. The signal output at these connectors is always on 

and cannot be disabled.

Connect the lower 10 MHz OUT connector to the REF CLK IN connector on the 

NI 5620 module front panel or to the CLK IN connector on the NI 5142.
10 MHz OUT

PXI 10 MHz I/O Provides bidirectional connection to the PXI 10 MHz backplane clock.

This connector can be used to drive the PXI 10 MHz backplane clock only when the 

NI 5600 is installed in PXI Slot 2. This connector can be used to export the 

PXI 10 MHz backplane clock when the NI 5600 RF downconverter is installed in any 

PXI slot. Refer to the help file for your device for more information.

OUTPUT Connects to the INPUT connector on the IF digitizer module front panel.

This connector is the output terminal for the frequency-translated IF signal for 

digitization.

INPUT Connects to the analog RF input signal to be measured by the RF vector signal analyzer.

Table 3.  NI 5600 RF Downconverter Module Front Panel LEDs

LED Indication

POWER Indicates the basic hardware power status of the NI 5600 RF downconverter module. 

This LED functions identically to the ACCESS LED on the digitizer module front panel.

OFF—The module is not yet functional or has detected a problem with a PXI power rail.

GREEN—The module is functional and receiving power.

STATUS Indicates the status of the NI 5600 RF downconverter module PLLs.

OFF—The module is in an uninitialized state, or the module PLLs are attempting to lock.

GREEN—The module is in a ready state; applicable PLLs are locked.
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NI 5620 IF Digitizer Module
The front panel of the NI 5620 IF digitizer module contains three connectors, as shown in Figure 11. 

Figure 11.  NI 5620 IF Digitizer Module Front Panel

50 Ω

+20 dBm MAX

50 Ω

+16 dBm MAX

INPUT

REF CLK IN

PFI 1

NI 5620
64 MS/s Digitizer
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Appendix B: Troubleshooting

This section discusses issues you may encounter during installation, configuration, and use of the 

RF vector signal analyzer hardware and software.

Installation

NI 5600 RF Downconverter Module Front Panel POWER LED is Off when PXI Chassis is On

If the POWER LED fails to light when the PXI chassis is powered on, a problem may exist with the 

PXI power rail, a hardware module, or the LED. Complete the following steps to troubleshoot this issue:

1. Power off your PXI chassis.

2. Remove any module front panel interconnections between the RF vector signal analyzer hardware 

modules.

3. Remove both RF vector signal analyzer hardware modules and inspect for damage. Do not reinstall 

a damaged device.

4. Reinstall both RF vector signal analyzer hardware modules in different PXI slots. Use the 

Installing PXI Modules procedure detailed in your device chapter. 

5. Power on your PXI chassis. 

6. If the POWER LED still fails to light, and failures continue, contact NI technical support or visit 

ni.com/support.

A Hardware Module Does Not Appear in MAX

Use the following procedure if any RF vector signal analyzer hardware module does not appear in MAX:

1. In the MAX Configuration pane, expand the Traditional NI-DAQ (Legacy) Devices folder. 

2. Press <F5> to refresh the list of installed devices.

3. If the module is still not listed, power off the system, ensure that the RF vector signal analyzer 

hardware is correctly installed, and restart the system. If your hardware still does not appear, 

continue to step 4.

Table 4.  NI 5620 IF Digitizer Module Front Panel Connectors

Connector Use 

INPUT Connects to the OUTPUT connector on the NI 5600 RF downconverter module front 

panel.

This connector is the input terminal for a frequency-translated IF waveform from the 

NI 5600 RF downconverter for digitization and measurement. 

REF CLK IN Connects to the lower 10 MHz OUT connector on the NI 5600 RF downconverter 

module front panel.

This connector is the input terminal for the NI 5600 internal reference clock signal.

PFI 1 Receives a digital trigger from an external source. Refer to the NI High-Speed Digitizers 

Help for more information about triggering.
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4. Open the Windows Control Panel and select System»Hardware»Device Manager. Complete the 

appropriate step for your setup:

• If you are using a PXI controller, verify that a National Instruments entry appears in the 

system device list. Reinstall the driver software and the RF vector signal analyzer hardware 

modules if error conditions are present in the list.

• If you are using a MXI-3 controller, right-click PCI-to-PCI Bridge and select Properties 

from the shortcut menu to verify that the bridge is enabled. 

5. If the module still fails to appear in MAX, contact NI technical support or visit ni.com/

support.

The RF Downconverter Module Fails the Self-Test

The MAX self-test performs a brief test of device resources. If the NI 5600 does not pass the self-test, 

complete the following steps:

1. Restart your system.

2. Launch MAX and perform the self-test again.

3. Reinstall the NI 5600 module in a different slot as described in your device chapter.

4. Perform the self-test again.

5. If the NI 5600 RF downconverter module still fails the self-test, contact NI technical support or 

visit ni.com/support.

The IF Digitizer Module Fails the Self-Test

The MAX self-test performs a brief device resources test. If the IF digitizer module does not pass the 

self-test, complete the following steps:

1. Launch MAX by navigating to Start»All Programs»National Instruments»Measurement & 

Automation or by clicking the MAX desktop icon.

2. In the Configuration pane, double-click Devices and Interfaces to see the list of installed devices.

3. In MAX, expand one of the following folders:

• For the NI 5620, expand the Traditional NI-DAQ (Legacy) Devices folder. You will see a 

list of installed devices that includes the NI 5600 RF downconverter and NI 5620 IF digitizer 

modules.

a. Right-click the IF digitizer module name and select Properties.

b. The Configuring Device dialog appears. Click Test Resources.

c. In the Configuring Device dialog box, select Run Test Panels. The test panel performs 

a functional test of the IF digitizer module.

• For the NI 5142 and NI 5622, expand the NI-DAQmx Devices folder. You will see a list of 

installed devices that includes the NI 5600/5601 RF downconverter and NI 5142/5622 IF 

digitizer modules.

a. Right-click the IF digitizer module name and select Self-Test.

4. Click the Start button to run the test panel.

5. When the test panel has run successfully, click Close. 

6. Click OK in the Configuring Devices dialog box to return to MAX.

7. If the test panel fails and continues to fail, contact NI technical support or visit ni.com/

support. 



NI PXI-5660 Getting Started Guide 22 ni.com

Configuration

RF Vector Signal Analyzer Does Not Initialize

Failure to initialize may indicate a problem with module interconnection or with MAX. If the RF vector 

signal analyzer fails to initialize, complete the following steps:

1. Reconnect the RF vector signal analyzer hardware module front panel cables securely as shown in 

your device chapter. 

2. Power on your system and run the MAX configuration and self-test procedures in the 7. 

Configuring and Programming the NI 5660 section.

3. If failures continue, contact NI technical support or visit ni.com/support.

NI 5600 RF Downconverter STATUS LED Does Not Light

If the RF vector signal analyzer is programmed to lock to an external reference source or to the PXI 

backplane but the STATUS light does not indicate a phase locked status, check for the following errors:

• Verify that a cable is connected from the external source or the PXI 10 MHZ I/O connector to the 

FREQ REF IN connector. 

• Ensure that the external source signal is large enough—typically greater than –10 dBm.

• Ensure the external source signal falls within the specified frequency accuracy.

If you programmed the RF vector signal analyzer to use the NI 5600 RF downconverter module internal 

timebase, check for the following errors:

• If the RF vector signal analyzer measures the frequency incorrectly or detects no signal when one 

is supplied, one or more of the local oscillators is not phase-locked. 

• If the RF vector signal analyzer measures the frequency correctly but the LED does not light, there 

could be a driver software error or the LED is damaged.

• If failures continue, contact NI technical support or visit ni.com/support. 

The NI 5620/5142 IF Digitizer Module Does Not Phase-Lock to the RF Downconverter Module

If you programmed the IF digitizer module to phase-lock to the NI 5600 RF downconverter module 

internal reference through the front panel and you encounter failure, check for the following errors:

1. Verify that the cable is not faulty. 

2. Ensure that there is a reference signal output from the NI 5600 10 MHZ OUT front panel 

connectors. 

3. If there is no signal at these output terminals, contact NI technical support or visit ni.com/

support.

If you programmed the IF digitizer module to phase-lock to the PXI backplane driven by the NI 5600 

RF downconverter module internal reference and you encounter failure, check for the following errors:

• Ensure that the NI 5600 is in Slot 2 of the PXI chassis, immediately adjoining the PXI controller 

slot. 

• Verify that the PXI 10 MHZ I/O connector is securely wired to one of the 10 MHz OUT connectors 

using the included cable, as shown in your device chapter. 

• Verify that the drive backplane clock parameter of the ni5660 Configure Reference Clock VI is 

set to TRUE.

If failures or errors continue, contact NI technical support or visit ni.com/support.
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Measurements
For more information about making measurements with the RF vector signal analyzer, refer to the 

NI PXI-5660 Help.

RF Vector Signal Analyzer Amplitude Reading Does Not Match Source

If the RF vector signal analyzer reports an incorrect amplitude reading, check for the following possible 

errors:

1. Check that the discrepancy between the RF vector signal analyzer and the source is within the error 

limits of the devices, as follows: 

a. Verify the absolute amplitude accuracy of the RF vector signal analyzer.

b. Verify the output level accuracy of the source.

2. Check for loss in the cables, which can be substantial. For example, RG58 coaxial cable loses about 

2.1 dB of signal amplitude per foot at 2 GHz. Unless you are using high-quality cables, expect 

losses when working with high-frequency signals.

3. Ensure that you are using the amplitude calibration functions in the NI Spectral Measurements 

Toolkit. Failure to apply calibration functions can result in large amplitude errors.

4. If errors continue, contact NI technical support or visit ni.com/support.

Technical Support and Professional Services

Visit the following sections of the award-winning National Instruments Web site at ni.com for 

technical support and professional services:

• Support—Technical support at ni.com/support includes the following resources:

– Self-Help Technical Resources—For answers and solutions, visit ni.com/support for 

software drivers and updates, a searchable KnowledgeBase, product manuals, step-by-step 

troubleshooting wizards, thousands of example programs, tutorials, application notes, 

instrument drivers, and so on. Registered users also receive access to the NI Discussion 

Forums at ni.com/forums. NI Applications Engineers make sure every question submitted 

online receives an answer.

– Standard Service Program Membership—This program entitles members to direct access 

to NI Applications Engineers via phone and email for one-to-one technical support as well as 

exclusive access to on demand training modules via the Services Resource Center. NI offers 

complementary membership for a full year after purchase, after which you may renew to 

continue your benefits. 

For information about other technical support options in your area, visit ni.com/services, 

or contact your local office at ni.com/contact. 

• Training and Certification—Visit ni.com/training for self-paced training, eLearning virtual 

classrooms, interactive CDs, and Certification program information. You also can register for 

instructor-led, hands-on courses at locations around the world.

• System Integration—If you have time constraints, limited in-house technical resources, or other 

project challenges, National Instruments Alliance Partner members can help. To learn more, call 

your local NI office or visit ni.com/alliance.

• Declaration of Conformity (DoC)—A DoC is our claim of compliance with the Council of the 

European Communities using the manufacturer’s declaration of conformity. This system affords 

the user protection for electromagnetic compatibility (EMC) and product safety. You can obtain the 

DoC for your product by visiting ni.com/certification.
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• Calibration Certificate—If your product supports calibration, you can obtain the calibration 

certificate for your product at ni.com/calibration.

If you searched ni.com and could not find the answers you need, contact your local office or NI 

corporate headquarters. Phone numbers for our worldwide offices are listed at the front of this manual. 

You also can visit the Worldwide Offices section of ni.com/niglobal to access the branch office 

Web sites, which provide up-to-date contact information, support phone numbers, email addresses, and 

current events.
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スタートアップガイド

NI PXI-5660
このマニュアルでは、NI PXI-5660無線周波数（RF）ベクトル信号アナライザの取り付け、
構成、テスト、および使用開始の方法を説明するとともに、RFベクトル信号アナライザの
プログラミング方法やプログラムサンプルを紹介します。その他のドキュメントについての
詳細は、「1. システム要件を確認する」セクションを参照してください。
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表記規則

このドキュメントでは以下の表記規則を使用します。

→ 矢印（→）は、ネスト化されたメニュー項目やダイアログボックスのオプションを
たどっていくと目的の操作項目を選択できることを示します。ファイル→ページ設
定→オプションと表記されている場合は、まずファイルメニューをプルダウンし、
次にページ設定項目を選択し、最後にダイアログボックスでオプションを選択しま
す。

 このアイコンは、ユーザへのアドバイスを示します。
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 このアイコンは、注意すべき重要な情報を示します。

 このアイコンは、人体への損傷やデータ損失、システムクラッシュなどを回避す
るために必要な注意事項を示します。製品にこの記号が付いている場合は、『はじ
めにお読みください : 安全対策と電磁両立性について』を参照して必要な安全対策
を講じてください。

この記号は、電気ショックを防止するための事前対策についての警告を示します。

この記号は、熱を帯びる可能性があるコンポーネントを示します。このコンポーネ
ントに接触すると、負傷する可能性があります。

太字 太字のテキストは、メニュー項目やダイアログボックスオプションなど、ソフト
ウェアでユーザが選択またはクリックする必要がある項目を示します。また、パラ
メータ名も示します。

monospace このフォントのテキストは、キーボードから入力する必要があるテキストや文字、
コードの一部、プログラムサンプル、構文例を表します。また、ディスクドライブ
名、パス名、ディレクトリ名、プログラム名、サブプログラム名、サブルーチン
名、デバイス名、演算名、変数名、ファイル名と拡張子にも使用します。

monospace ユーザが入力する必要がある語または値のプレースホルダを示します。
斜体

プラット 特定のプラットフォームを表し、そのすぐ後の記述はそのプラットフォームのみに
フォーム 適用されることを示します。

1. システム要件を確認する
NI RFベクトル信号アナライザを使用するには、特定の要件を満たすシステムが必要です。
詳細な最低要件、推奨要件、サポートされるアプリケーション開発環境（ADE）について
は、NI-RFSAソフトウェアに含まれる『NI RF信号アナライザ Readme』を参照してくだ
さい。

メモ NI-RFSAをインストール済みのコンピュータでは、スタート→すべてのプログラム→
National Instruments→ NI-RFSA→ドキュメントを選択するか、ni.com/support/ja/

downloadよりオンラインで『NI RF信号アナライザ Readme』を閲覧できます。

2. デバイスをパッケージから取り出す
RF信号アナライザのハードウェアモジュールは、静電気放電（ESD）による破損を防ぐた
めに静電気防止用パッケージで包装し出荷されます。ESDはハードウェアモジュールのコ
ンポーネント破損の原因となる可能性があるため、すべてのモジュールは、使用していない
ときは静電気防止用袋に入れて保管してください。

注意 露出しているコネクタピンには絶対に触れないでください。



© National Instruments Corporation 3 NI PXI-5660 スタートアップガイド

RFベクトル信号アナライザのハードウェアモジュールの取り扱い中に破損しないよう、
以下の予防措置を実行してください。

� 接地ストラップを使用したり、接地されている物体に触れて、身体を接地する。

� 静電気防止用パッケージをシャーシの金属部分に接触させてから、ハードウェアモ
ジュールを取り出す。

各ハードウェアモジュールをパッケージから取り出し、部品がゆるんでいないかどうか、
また、破損箇所がないかどうか調べます。いずれかのハードウェアモジュールが破損してい
る場合は、ナショナルインスツルメンツまでご連絡ください。破損しているモジュールはシ
ステムに取り付けないでください。

3. キットの内容を確認する
RFベクトル信号アナライザの設定および使用には以下が必要です。見出しの四角マークは、
キットに含まれる実際の機器、部品類を表します。

❑ ドライバソフトウェアのディスク—NI-RFSAおよび ni5660計測器ドライバソフトウェ
ア、および以下のドキュメントを含む電子ドキュメントをインストールします。

– 『NI RF信号アナライザ Readme』—この HTMLドキュメントには、システムの
最低要件および推奨要件、新しい機能、インストールされるファイルの保存場所、
および NI-RFSA計測器ドライバソフトウェアのアンインストールと変更の方法に
ついての情報が記載されています。

– 『NI PXI-5660 Help』—このオンラインドキュメントはスタート→すべてのプログ
ラム→ National Instruments→ NI-RFSA→ドキュメントにあり、NI 5660 RFベ
クトル信号アナライザの操作方法を習得する場合にお読みください。

– 『NI 高速デジタイザヘルプ』—このオンラインヘルプドキュメントはスタート→す
べてのプログラム→ National Instruments→ NI-SCOPE→ドキュメントにあり、
お使いの RFベクトル信号アナライザの一部として含まれている IFデジタイザモ
ジュールの詳細について習得する場合にお読みください。

– 『NI-TUNER Help』—このオンラインドキュメントは Program Files¥National 

Instruments¥<LabVIEW>¥Helpディレクトリにあり、RFダウンコンバータモ
ジュールおよび IFデジタイザモジュール用計測器ドライバの機能の詳細について
調べる場合にお読みください。

❑ NIスペクトル計測ツールキット CD—スペクトル計測ツールキット（SMT）ソフトウェ
アコンポーネントをインストールします。このコンポーネントには、SMTの VIおよび
関数、サンプル、ドキュメントが含まれます。

❑ 1/8 in. プラス /マイナスドライバー

❑ 以下の印刷版ドキュメント類 :

– NI PXI-5660 スタートアップガイド（このドキュメント）

– お使いのデバイスに付属する仕様書

– はじめにお読みください : 安全対策と電磁両立性について

– 強制空冷の維持について
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❑ 2つのハードウェアモジュール

– NI 5600 RFダウンコンバータモジュール

– NI 5620 IFデジタイザモジュール

❑ モジュールを相互接続するための短いケーブル類

– セミリジッド SMA-SMA同軸ケーブル（短）×1

– セミリジッド SMA-SMA同軸ケーブル（長）×1

– セミフレキシブル SMA-SMA同軸ケーブル ×1

❑ 同軸ケーブルの六角コネクタ固定用プラスチックカラー（ケーブルレンチ）

その他必要となるもの

❑ 以下のうちいずれか

– （PXIシステム） PXIシャーシ、このガイドで指定されたシステム要件を満たす PXI
組込またはMXIコントローラシステム、およびシャーシ関連ドキュメント。

– （PXI Expressシステム） PXI Expressシャーシ、PXI Express組込または
MXI Expressコントローラ、およびシャーシ関連ドキュメント。

❑ 1 N・m標準 SMAトルクレンチ（部品番号 187106-01）、付属の SMAドライバービット
と使用
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図 1  NI 5660キット内容および交換製品番号

1 NI PXI-1042または PXI-1045シャーシ

（別途ご用意ください）
2 NI 5600 RFダウンコンバータモジュール

3 NI 5620 IFデジタイザモジュール

4 セミリジッド SMA-SMAケーブル（短）（763480-01）

5 セミリジッド SMA-SMAケーブル（長）（763481-01）

6 セミフレキシブル SMA-SMAケーブル（763488-01）

7 ケーブルレンチ ×2（746016-01）

8 ドライバー（772006-01）

4 5 6

1

NI PXI-1042

87

2

NI 5600

POWER

STATUS

RF DOWNCONVERTER

+20 dBm MAX

+30 dBm MAX
WITH ATTN

3
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4. ソフトウェアをインストールする
計測器ドライバソフトウェアのコンポーネントをインストールするには、以下の手順に従っ
てください。RFベクトル信号アナライザのハードウェアを取り付ける前に、必ずすべての
付属ソフトウェアをインストールしてください。

1. LabVIEW、LabWindows™/CVI™などのアプリケーション開発環境（ADE）、または他
社製プログラムはそれぞれの説明書に従ってインストールしてください。また、使用す
る開発環境のインストールは、ドライバソフトウェアおよびスペクトル計測ツールキッ
トをインストールする前に行う必要があります。

2. NI-RFSA ディスクを CD/DVDドライブに挿入し、インストール画面の指示に従いま
す。NI-RFSA 2.1（NI PXI-5661および NI PXIe-5663）および NI PXI-5660サポート、
またはいずれか一方を選択できます。

（Windows Vista） アクセス /セキュリティメッセージが表示される場合があります。
画面の指示に従って、インストールを完了します。

メモ インストール画面が開かない場合は、該当するディスクドライブを開いて
setup.exeをダブルクリックします。

3. LabVIEW Real-Timeモジュールを実行するシステムを使用する場合は、
Measurement & Automation Explorer（MAX）にて NI-RFSAをターゲットにダウン
ロードします。MAXリモートシステムの詳細については、MAXでヘルプ→ヘルプ
トピック→リモートシステムを選択し、『MAXリモートシステムヘルプ』を参照して
ください。

4. インストールが完了したら、ドライバソフトウェアのディスクを取り出します。

メモ ドライバソフトウェアのインストールは、スペクトル計測ツールキットをインス
トールする前に行う必要があります。

5. スペクトル計測ツールキットCDを挿入します。

6. 使用する ADEに対してスペクトル計測ツールキットをインストールします。インス
トール画面の指示に従います。

7. インストールが完了したら、スペクトル計測ツールキット CDを取り出します。

メモ RFベクトル信号アナライザの機能を最大限に活用するには、このアナライザに同
梱されているスペクトル計測ツールキットをインストールする必要があります。スペク
トル計測ツールキットを使用すると、RFベクトル信号アナライザの機能が周波数領域お
よび変調領域の測定、アナログ変調された IF信号の解析にまで拡張されます。

8. RFベクトル信号アナライザと併用する他のソフトウェアのインストールは、ドライバ
ソフトウェアおよびスペクトル計測ツールキットをインストールした後に行います。

メモ RFデバイスと併用するツールキットまたは他のソフトウェアのインストールをド
ライバソフトウェアのインストール前に行った場合は、ドライバソフトウェアおよびス
ペクトル計測ツールキットをインストールした後にこれらを再インストールするか、修
復してください。

メモ スペクトル計測ツールキットにはアナログ変復調のサンプルが含まれています。
モジュレーションツールキットにはデジタル変復調測定機能が含まれます。お使いの RF
ベクトル信号アナライザのキットには両方のツールキットが含まれている場合がありま
す。また、NIモジュレーションツールキットは ni.comでご購入、インストールできま
す。NI PXI-5660サポートおよびスペクトル計測ツールキットのインストールは、モジュ
レーションツールキットをインストールする前に行います。
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5. NI 5660を取り付ける
NI 5660モジュールは、PXIフォームファクタで使用することができます。NI 5660 RFベク
トル信号アナライザハードウェアモジュールを取り付けるには 4つの空き PXI（またはハイ
ブリッド）スロットが必要です。4つのうち 3つは NI 5600 RFダウンコンバータモジュー
ル用、残りの 1つは NI 5620 IFデジタイザモジュール用です。付属の同軸ケーブルを使用
するには、NI 5620は NI 5600のすぐ右側のスロットに取り付けてください。

メモ NI PXI-5660サポートはハードウェアを取り付ける前にインストールしておく必要
があります。

NI 5600 RFダウンコンバータモジュールを取り付ける
NI 5600モジュールの取り付けは、「PXIモジュールを取り付ける」セクションの手順 1か
ら 10に従ってください。

メモ NI 5600のオンボード周波数リファレンスは、RFダウンコンバータモジュールが
PXIスロット 2に取り付けられている場合にのみ PXIバックプレーンクロックを駆動でき
ます。NI 5600が PXIスロット 2に取り付けられていると、高確度、高安定性のオン
ボード恒温水晶発振器（OCXO）に PXIバックプレーンクロックをロックするように
NI 5600を構成できます。また、NI 5600を外部周波数基準クロック信号に対してロック
し、この基準をバックプレーンへ駆動することもできます。外部周波数基準を使用する
には、この信号を NI 5600モジュールフロントパネル上の FREQ REF INコネクタに接続
する必要があります。

NI 5620 IFデジタイザモジュールを取り付ける
NI 5620モジュールの取り付けは、「PXIモジュールを取り付ける」セクションの手順 2か
ら 11に従ってください。

PXIモジュールを取り付ける
NI PXIモジュールは精密機器であるため、取り扱いには注意が必要です。このモジュール
を、使用温度範囲または使用湿度範囲を超える環境に配置しないでください。

メモ 定格最大値についての詳細は、スタート→すべてのプログラム→ National 
Instruments→ NI-RFSA→ドキュメント→仕様にある、お使いのデバイスの仕様を参照
してください。

エアダスターを使用して、モジュールに付着するほこりを取り除いてください。手入れ時に
溶媒や液体は使用しないでください。

デバイスを取り扱う際は、ESDや汚れによる被害を避けるために、デバイスの端や金属ブ
ラケットを持ってください。お使いのハードウェアの無線周波数妨害特性についての詳細
は、ドキュメント『はじめにお読みください : 安全対策と電磁両立性について』を参照して
ください。

注意 デバイスを取り付ける前に、必ずシャーシの電源を切り、電源プラグを抜いてく
ださい。

PXIモジュールは、グリフ（円で囲まれたスロット番号）の記載がある任意の
PXIスロットに取り付けることができます。

また、PXIモジュールは、周辺スロットとの互換性を示すグリフ（文字 "H"と
塗りつぶされた円で囲まれたスロット番号）の記載がある任意の PXIハイブ
リッドスロットに取り付けることができます。

3

7

H
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PXIモジュールを取り付けるには、以下の手順に従ってください。

1. PXIシャーシの電源を切り、電源プラグを抜きます。

2. シャーシにファンの速度設定が複数ある場合は、ファンの設定を HIGHにします。
ファンの速度を LOWに設定したり、ファンを停止しないでください。

3. シャーシのファンの吸気口と排気口の間に充分な空間を確保できる場所に置きます。こ
の空間が壁や障害物でふさがれていると、冷却に必要な空気の流れに影響します。冷却
に関する詳細については、それぞれのシャーシ関連ドキュメントを参照してください。

4. 着脱用ハンドルがラッチされていない状態（下向き）になっていることを確認します。

5. モジュールのフロントパネルにある取り付けネジからゴム製ネジカバーを取り外しま
す。

6. モジュールの脱着ハンドル部分を持ちながら、図 2のようにモジュールを使用可能な
PXI（またはハイブリッド）スロットに差し込みます。モジュールのベースカード（モ
ジュールの正面から見て左側のカード）がシャーシのカードガイドに固定されているこ
とを確認します。

7. モジュールを完全にシャーシに押し込み、脱着ハンドルを引き上げて固定します。

8. モジュールのフロントパネルにあるネジを締めてモジュールを固定します。ネジが適切
に締められていないと、パフォーマンスに影響が出る恐れがあります。

9. PXIシャーシファンが動作し、通気を妨げるようなほこりや汚れがついていないことを
確認します。

10. RFベクトル信号アナライザハードウェアモジュールの取り付け後、すべてのシャーシ
カバーおよびフィラーパネルを取り付けます。フィラーパネルが取り付けられていない
場合、シャーシ内で空気の循環が適切に行われません。

メモ NIでは、RFベクトル信号アナライザハードウェアモジュールの冷却のための通
気が最大限に確保できるように隣接の空き PXIスロットにスロットブロッカーを取り付
けることを推奨しています。PXIシャーシスロットブロッカーキット（製品番号 
778678-01）は ni.com/jpで購入可能です。

11. PXIシャーシの電源プラグを接続し、電源を投入します。
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図 2に、互換性のあるシャーシスロットに PXIモジュールが正しく取り付けられている状
態を示します。

 

図 2  PXIモジュールの取り付け

PXIモジュールを取り外す
PXIモジュールを取り外す前にシャーシの電源を切ります。PXIモジュールをシャーシから
取り外す際は、接地ストラップを装着したり接地された金属面に触れるなど、必ず身体に接
地対策を施してください。ESDを防止するため、デバイスの露出したコネクタピンや回路
には触れないでください。PXIデバイスは、使用していないときは元の静電気防止用袋に入
れて保管してください。

熱面 PXIデバイスの金属面は、稼働中に高温となる場合があります。デバイスを
シャーシから取り外す、または別の周辺機器スロットへ移動する際は注意してください。
デバイスを取り外す際は、着脱用ハンドルとフロントパネルのみに触れるようにしてく
ださい。

1 PXIシャーシ

2 ラッチされていない脱着ハンドル

3 取り付けネジ（ゴム製ネジカバーを外した状態）

4 NI PXIモジュール

NI PXI-10423
4

1

2
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6. NI 5660モジュールを相互接続する
NI 5600および NI 5620はモジュールのフロントパネルを介して相互接続されます。RFベ
クトル信号アナライザハードウェアモジュールのフロントパネルコネクタを相互接続するに
は、図 3に示すように、手順 1から 6に従ってください。

 

図 3  付属の NI 5660ケーブルを使用したデバイスの相互接続

メモ 公開されている NI 5660 RFベクトル信号アナライザの仕様は付属ケーブルの使用
を前提としています。それ以外のケーブルを使用するとパフォーマンスに影響する場合
があります。

FREQ. REF IN
50 Ω

+16 dBm MAX
±5V DC MAX

10 MHz OUT
1 V pp 50 Ω

PXI 10 MHz I/O
50 Ω

+23 dBm MAX
± 5 V DC MAX INPUT

50 Ω

0 V DC MAX

50 Ω

+16 dBm MAX

50 Ω

+20 dBm MAXOUTPUT
50 Ω

5 MHz - 25 MHz

INPUT

REF CLK IN

PFI 1

NI 5600 NI 5620
64 MS/s Digitizer

POWER

STATUS

RF DOWNCONVERTER

+20 dBm MAX

+30 dBm MAX

WITH ATTN
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1. セミリジッド同軸ケーブル（短）を使用して、NI 5600 RFダウンコンバータのフロン
トパネル上のOUTPUTコネクタを NI 5620 IFデジタイザのフロントパネル上の INPUT
コネクタに接続します。

メモ セミリジッドケーブルは、図 3に示すように折り曲がった部分が上向きになるよ
うに取り付けてください。

2. セミリジッド同軸ケーブル（長）を使用して、NI 5600のフロントパネル上の 2つの
10 MHz OUTコネクタのうちの下側を NI 5620のフロントパネル上の REF CLK INコネ
クタに接続します。

メモ NI 5600のオンボード周波数リファレンスは、RFダウンコンバータモジュールが
PXIスロット 2に取り付けられている場合にのみ PXIバックプレーンクロックを駆動でき
ます。NI 5600が PXIスロット 2に取り付けられていると、高確度、高安定性のオン
ボード恒温水晶発振器（OCXO）に PXIバックプレーンクロックをロックするように
NI 5600を構成できます。また、NI 5600を外部周波数基準クロック信号に対してロック
し、この基準をバックプレーンへ駆動することもできます。外部周波数基準を使用する
には、この信号を NI 5600モジュールフロントパネル上の FREQ REF INコネクタに接続
する必要があります。

3. （オプション） セミフレキシブル同軸ケーブルを使用して、NI 5600のフロントパネル上
の双方向 PXI 10 MHz I/Oコネクタを NI 5600のフロントパネル上の上側の 10 MHz 
OUTコネクタに接続します。

注意 SMAコネクタが適正なトルクで締められていないと、信号の信頼性、位相ロック
ループ（PLL）のパフォーマンスが低下し、および挿入損失が起こります。すべての
SMAコネクタを 1 N・mの適正トルクで確実に締められるように、SMA用トルクレン
チを使用してください。

4. 図 3に示すように、SMA用トルクレンチ（別途ご用意ください）を使用して、注意し
ながらすべての SMAコネクタを 1 N・mのトルクで締めます。レンチがカチッと音が
すると適正なトルクです。

5. PXIシャーシおよびコントローラシステムの電源プラグを差し込み、電源を投入しま
す。

6. NI 5600 RFダウンコンバータモジュールの POWER LEDが点灯していることを確認し
ます。LEDが点灯していない場合は、「付録 B: トラブルシューティング」を参照してく
ださい。

これで、NI 5660 RFベクトル信号アナライザの取り付けが完了しました。

冷却について
PXIデバイスの取り付け時は、キットに付属の『強制空冷の維持について』のガイドライン
に従い、デバイスを効率的に冷却してください。

注意 空気の循環が不十分だと、シャーシ内部の温度が RFベクトル信号アナライザ
ハードウェアモジュールの最適な動作温度以上に上昇して、過熱遮断、製品寿命の短縮、
または不適切な動作の原因となる可能性があります。
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7. NI 5660を構成およびプログラミングする
Measurement & Automation Explorer（MAX）を使用すると、お使いの NIハードウェ
アを構成できます。MAXはデバイスがシステムにどのように接続し、構成されているかに
ついての情報を他のプログラムに通知します。MAXはドライバソフトウェアのインストー
ル時に自動的にインストールされます。

MAXを使用して NI 5660 RFベクトル信号アナライザハードウェアモジュールの構成、セル
フテスト、および機能テストを行うには、以下の手順に従ってください。

1. スタート→すべてのプログラム→ National Instruments→Measurement & 
Automationを選択するか、MAXのデスクトップアイコンをクリックしてMAXを起
動します。

2. 取り付けられているデバイスのリストを表示するには、構成ペーンでデバイスとインタ
フェースをダブルクリックします。

3. 従来型 NI-DAQ（レガシー）デバイスフォルダを展開します。NI 5600および NI 5620
モジュールを含む、取り付けられているデバイスのリストが表示されます。（デフォル
トのデバイス名は使用状況により異なります。）

メモ NI 5600および NI 5620モジュールがリストに表示されない場合は、「付録 B: トラ
ブルシューティング」を参照してください。

4. MAXがお使いの RFベクトル信号アナライザハードウェアモジュールに割り当てたデ
バイス番号をメモします。これらの番号は RFベクトル信号アナライザをプログラミン
グする際に使用されます。

両モジュールのセルフテストを行うには手順 5から 11に従ってください。

5. NI PXI-5600を右クリックして、プロパティを選択します。

6. 構成デバイスダイアログボックスが表示されます。テストリソースをクリックして、

NI 5600 RFダウンコンバータハードウェアモジュールのセルフテストを行います。
MAXのセルフテストでは、ハードウェアリソースの基本的確認を行います。

7. NI-DAQ構成ユーティリティダイアログボックスが表示されるので、セルフテストの実
行を確認します。OKをクリックし、構成デバイスダイアログボックスに戻ります。

メモ NI 5600 RFダウンコンバータモジュールのセルフテストに失敗した場合は、
「付録 B: トラブルシューティング」を参照してください。

8. NI 5600構成デバイスダイアログボックスでOKをクリックし、MAXに戻ります。

9. NI PXI-5620を右クリックして、プロパティを選択します。

10. 構成デバイスダイアログボックスが表示されます。テストリソースをクリックして、
NI 5620 IFデジタイザハードウェアモジュールのセルフテストを行います。

11. NI-DAQ構成ユーティリティダイアログボックスが表示されます。OKをクリックして
構成デバイスダイアログボックスに戻り、NI 5620テストパネルの操作を続行します。

メモ NI 5620 IFデジタイザモジュールのセルフテストに失敗した場合は、「付録 B: トラ
ブルシューティング」を参照してください。

これで、NI 5660 RFベクトル信号アナライザのセットアップ、構成、およびテストが完了
しました。
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両方のモジュール名を変更する
MAXにより、両方の NI 5660ハードウェアモジュールの名前を変更できます。ソフトウェ
アでMAXにあるモジュール名を使用して NI 5660ハードウェアリソースを操作します。モ
ジュール名は変更せずに、MAXで割り当てられたデフォルト名のままでもかまいません
が、変更することでプログラムがより読みやすくなることがあります。モジュール名を変更
しない場合には、「対話式にデータを集録する」セクションに進みます。

両方の NI 5660ハードウェアモジュールの名前を変更するには、手順 1から 7に従ってく
ださい。

1. NI PXI-5600を右クリックして、ショートカットメニューから名前の変更を選択しま
す。

2. NI 5600モジュールに付ける新規の名前を入力します。

メモ デバイス名には英数字と下線文字のみ使用できます。

3. OKをクリックします。

4. NI PXI-5620を右クリックして、ショートカットメニューから名前の変更を選択しま
す。

5. NI 5620モジュールに付ける新規の名前を入力します。

6. OKをクリックします。

7. 次のセクションに進む前に、両方のモジュールに付けた新規の名前が表示されているこ
とを確認します。

対話式にデータを集録する
RFベクトル信号アナライザを使用して対話式にデータを集録したり測定を行うには、付属
の RFSA Demo Panelを使用します。RFSA Demo Panelは、MAXでツール→ソフトフロ
ントパネル→ NI5660 - RFSA Demo Panelから、またはスタート→すべてのプログラム→
National Instruments→ NI-RFSA→ 5660 Demo Panelのスタートメニューから開くこと
ができます。

ヒント 外部信号源が使用できない場合は、NI 5600 RFダウンコンバータモジュールの
フロントパネルにある 10 MHz OUTコネクタからの信号出力を信号源として使用して適
切に RFベクトル信号アナライザが取り付けられていることを確認し、この信号出力を
RFSA Demo Panelに対するライブ信号として使用できます。この信号を使用するには、
NI 5600モジュールの 10 MHz OUTコネクタを NI 5600 RFダウンコンバータのフロント
パネル上の INPUTコネクタに接続します。
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（図 4に示す）RFSA Demo Panelでは、使いやすいソフトウェアインタフェースにより
RFベクトル信号アナライザハードウェアを操作でき、一般的な周波数領域測定および I/Q
測定が行えます。

ヒント RFSA Demo Panelのすべての制御器および表示器の詳細ヘルプを表示するに
は <Ctrl-H>を押してください。

図 4  ACP測定を実行中の RFSA Demo Panel

RFSA Demo Panelを使用するには、以下の制御器を構成します。

1. RFSADeviceNumbersダイアログボックスのデバイス番号がMAXで RFベクトル信
号アナライザハードウェアモジュールに割り当てられたデバイス番号と一致しているこ
とを確認し、OKをクリックします。

2. Hardware Settings（ハードウェア設定）制御器で、以下のパラメータを含む測定の
ハードウェアパラメータを指定します。

� RF Spectrum Settings（RFスペクトル設定）

� Amplitude（振幅）

� Timing（タイミング）

� Advanced Spectral Parameters（上級スペクトルパラメータ）

� Devices（デバイス）

1 Measurements（測定）制御器

2 Hardware Settings（ハードウェア設定）制御器
3 Averaging（平均化）制御器

4 Units（単位）制御器
5 波形グラフ

1

2

5

34
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3. Measurements（測定）で、実行したい測定を指定します。以下のオプションのうち
1つを選択できます。

� Peak Search（ピーク検出）

� Delta Peak（デルタピーク）

� Power in Band（帯域内電力）

� Adjacent Channel Power (ACP)（隣接チャンネル漏洩電力）

� Occupied Bandwidth（占有帯域幅）

� IQ Data（IQデータ）

4. Averaging Type（平均化タイプ）で、返されるデータに適用される平均化を指定しま
す。図 5にスペクトル平均化のオプションの階層を示します。

図 5  RFSA Demo Panelのスペクトル平均化のオプション

5. Units（単位）で、測定結果を返す単位を指定します。一般的に使用される単位が指定
できます。

Exponential ( )

Average Size ( )

Peak Hold
( )

No Averaging
( )

Vector
( )

RMS

Averaging 

Type
(

)

Linear ( )

Weighting

Type
(

)

Linear

Weighting

Mode
(

)

Moving Average
( )

Auto Restart
( )

Continuous

( )
One Shot

( )
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ハードウェアをプログラム的に構成する
NI 5660 RFベクトル信号アナライザハードウェアをデータ集録用にプログラム的に構成す
るには、表 1に示すように、2つの方式が使用できます。

メモ スペクトル計測ツールキットは、プログラミング方式にかかわらず、集録された
データを測定するために使用します。

LabVIEWで RFベクトル信号アナライザをプログラミングする
LabVIEWでのデータ集録用に RFベクトル信号アナライザハードウェアをプログラム的に
構成するには、ni5660 VIを使用します。これらの VIは NI 5600 RFダウンコンバータモ
ジュールおよび NI 5620 IFデジタイザモジュールの両方を、周波数領域および I/Qデータ
集録用に単一の計測器として制御します。ni5660 VIは LabVIEW関数パレットの計測器
I/O→計測器ドライバ→ ni5660にあります。

ni5660 LabVIEW VIのプログラミングフロー
ni5660 VIは、周波数領域集録プログラミングフローおよび I/Q集録プログラミングフロー
の 2つのプログラミングフローを使用します。ni5660 VIを使用して構築したすべてのアプ
リケーションは、「ni5660 Initialize」VIと「ni5660 Close」VIを呼び出す必要があります。

周波数領域測定プログラミングフロー

ni5660 VIを使用してデータを集録し周波数領域測定を行うには、図 6に示すようなプログ
ラミングフローを使用します。周波数スペクトルを集録するには「ni5660 Configure for 
Spectrum」VIおよび「ni5660 Read Averaged Power Spectrum」VIを使用します。

図 6  周波数スペクトルを集録する

表 1  RFベクトル信号アナライザのプログラム的構成方式

プログラミング方式 利点 対応 ADE

ni5660 VI 上位レベルのアプリケーションプログラミングイ
ンタフェース（API）による使用の簡易化、両方
の RFベクトル信号アナライザハードウェアモ
ジュールを単一の計測器として制御

一般的な周波数領域および I/Qの測定アプリケー
ションに対応

『NI RF信号アナライ
ザ Readme』を参
照

スペクトル計測ツー
ルキット、

NI-SCOPEおよび
NI-TUNERドライバ

下位レベルのアプリケーションプログラミングイ
ンタフェース（API）による独自のアプリケー
ションに対する最大限の柔軟性

RFダウンコンバータモジュールおよび IFデジタ
イザモジュールの計測器ドライバが提供する機能
を最大限に活用可能

『NI RF信号アナライ
ザ Readme』を参
照
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I/Q集録プログラミングフロー
I/Qデータをシングルショットモードまたは連続モードで集録するには、図 7（シングル
ショット）および図 8（連続）のそれぞれに示すようなプログラミングフローを使用しま
す。シングルショット IQデータの集録時に「ni5660 Configure for IQ Settings」VIおよ
び「ni5660 Read IQ」VIを使用します。連続 I/Qデータの集録時に「ni5660 Configure 
for IQ Settings」VI、「ni5660 Initiate IQ」VI、および「ni5660 Fetch IQ」VIを使用しま
す。

図 7  シングルショット I/Qデータを集録する

図 8  連続 I/Qデータを集録する

LabVIEWのサンプルアプリケーション
LabVIEWで使用可能な ni5660 VIのサンプルアプリケーションが用意されています。これ
らのサンプルは、対話式ツール、プログラミングモデル、およびユーザ開発のアプリケー
ションで構成ブロックとしての使用を意図しています。

インストール済みのすべての ni5660サンプルファイルは『NI RF信号アナライザ 
Readme』に記述された保存場所にあります。

LabVIEWのサンプルにはモジュレーションツールキットなどの NIツールキットソフト
ウェアと NI RF信号発生器を NI RFベクトル信号アナライザに統合する例があります。これ
らのサンプルおよびその詳細については、ni.com/examplesの「NI Developer Zone」
ウェブサイトを参照してください。
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LabWindows/CVIおよびCで RFベクトル信号アナライザをプログラミング
する

LabWindows/CVIおよび Cのユーザは RFベクトル信号アナライザハードウェアモジュー
ルを個別にプログラミングできます。これには、スペクトル計測ツールキットへの関数呼び
出し、および RFダウンコンバータモジュールと IFデジタイザモジュールの個々のドライバ
を使用します。以下のリストに各プログラムの役割を説明します。

� スペクトル計測ツールキットには、周波数領域測定および I/Q測定用として RFベクト
ル信号アナライザハードウェアのプログラミングに特化した関数が含まれています。

� NI-SCOPE計測器ドライバは NI 5620 IFデジタイザモジュールの動作および RFベクト
ル信号アナライザのトリガを制御します。

� NI-SCOPEおよびトリガについての詳細は、スタート→すべてのプログラム→
National Instruments→ NI-SCOPE→ドキュメントから『NI高速デジタイザヘルプ』
を参照してください。

� NI-TUNERドライバは NI 5600 RFダウンコンバータモジュールを制御します。

NI-TUNERについての詳細は、スタート→すべてのプログラム→ National 
Instruments→ NI-TUNER→ Documentationから『NI-TUNER Help』を参照してく
ださい。

図 9に、NI-SCOPEおよび NI-TUNERのソフトウェアコンポーネントを示します。

図 9  LabWindows/CVIおよび Cのソフトウェアフロー

メモ RFベクトル信号アナライザハードウェアをプログラム的に操作する場合は、
DAQリソース名を使用して以下の構文で NI 5620 IFデジタイザモジュールを指定しま
す。

DAQ::デバイス番号

NI 5600 RFダウンコンバータモジュールは修正キーなしのMAXデバイス番号で指定し
ます。

SMT

NI-TUNER

NI 5600

NI-SCOPE

NI 5620
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スペクトル計測ツールキットの概要
NIでは、スペクトル計測ツールキット（付属）やモジュレーションツールキットなどのア
ドオンソフトウェアツールキットを提供しています。これらを使用すると RFベクトル信号
アナライザの機能が拡張され、周波数領域測定および変調領域測定、アナログ変調された IF
信号の解析などが可能になります。

メモ RFベクトル信号アナライザに同梱のスペクトル計測ツールキット CDをインス
トールする必要があります。スペクトル計測ツールキットは RFベクトル信号アナライザ
を使用して変調信号を解析するために必要です。

RFベクトル信号アナライザを使用して周波数領域解析、測定、集録データの表示を行うに
はスペクトル計測ツールキット（SMT）VIおよびその関数を使用します。SMTは以下を含
む操作を行います。

� ズーム高速フーリエ変換（FFT）処理およびスペクトル平均化

� バンドパワー、隣接チャンネル漏洩電力、ピーク周波数および振幅などのスペクトル測
定

� スペクトルの表示および解析

� 周波数領域測定用の RFベクトル信号アナライザハードウェア構成

SMT VIおよび関数についての詳細な情報は、スタート→すべてのプログラム→ National 
Instruments→スペクトル計測を選択してスペクトル計測ツールキットのドキュメントを参
照してください。モジュレーションツールキットについての詳細は、ni.com/rf/

softwareを参照してください。

LabWindows/CVIおよびCの SMTサンプルアプリケーション
スペクトル計測ツールキットには、RFベクトル信号アナライザハードウェア用の
LabWindows/CVIおよび Cのサンプルが含まれています。スペクトル計測ツールキット
のサンプルはスタート→すべてのプログラム→ National Instruments→ Spectral 
Measurements→ CVI Supportを選択して開くことができます。サンプルファイルは
『NI RF信号アナライザ Readme』に記述された保存場所にあります。
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付録 A:ハードウェアフロントパネルのコネクタおよびインジケータ
このセクションでは、3つの RFベクトル信号アナライザハードウェアモジュールすべての
フロントパネルにあるコネクタや LEDインジケータについて説明します。NI 5622 IFデジ
タイザのフロントパネル上の PFI 1コネクタ以外のすべての入力端子および出力端子は AC
カプリングされています。

メモ 標準的な RFベクトル信号アナライザのハードウェアモジュールのフロントパネ
ル相互接続については、図 3「付属の NI 5660ケーブルを使用したデバイスの相互接続」
を参照してください。

NI 5600 RFダウンコンバータモジュール
図 10に示すように、NI 5600 RFダウンコンバータモジュールのフロントパネルには 6つの
コネクタと 2個の LEDがあります。

図 10  NI 5600 RFダウンコンバータモジュールのフロントパネル

INPUT
50 Ω

0 V DC MAX

OUTPUT
50 Ω

5 MHz - 25 MHz

+20 dBm MAX
+30 dBm MAX

WITH ATTN

PXI 10 MHz I/O
50 Ω

+23 dBm MAX
± 5 V DC MAX

10 MHz OUT
1 V pp 50 Ω

FREQ. REF IN
50 Ω

+16 dBm MAX
±5 V DC MAX

NI 5600

POWER

STATUS

RF DOWNCONVERTER
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メモ PXI 10 MHz I/Oコネクタは、NI 5600 RFダウンコンバータモジュールが PXIス
ロット 2に取り付けられている場合にのみ、基準クロック信号を PXIバックプレーンに
経路接続するために使用できます。このコネクタは、いずれの NI 5600 PXI取り付けス
ロットからも PXI 10 MHzバックプレーンクロックをエクスポートできます。基準クロッ
ク信号のエクスポート方法の詳細については、『NI PXI-5660 Help』を参照してくださ
い。

表 2  NI 5600 RFダウンコンバータモジュールのフロントパネルのコネクタ

コネクタ 使用

FREQ REF IN NI 5600がロック可能な外部周波数基準信号を経路接続します。NI 5600が
PXIスロット 2に取り付けられている場合、この信号を PXIバックプレーンに
伝播できます。

10 MHz OUT ダウンコンバータ 10 MHz周波数基準信号の複製を生成します。これらの複製
された信号はまた、他のデバイスを駆動する場合にも役立ちます。複製はそ
れぞれ互いに位相が 180度ずれています。これらのコネクタの出力信号は常
に出力されており、無効にすることはできません。

10 MHz OUT 下側の 10 MHz OUTコネクタを、NI 5620モジュールのフロントパネル上の
REF CLK INコネクタまたは NI 5142のCLK INコネクタに接続します。

PXI 10 MHz I/O PXI 10 MHzバックプレーンクロックとの双方向接続です。

NI 5600が PXIスロット 2に取り付けられている場合にのみ、PXI 10 MHz
バックプレーンクロックを駆動するためにこのコネクタを使用できます。ま
た、NI 5600ダウンコンバータがいずれの PXIスロットに取り付けられている
場合にも、PXI 10 MHzバックプレーンクロックをエクスポートするためにこ
のコネクタを使用できます。詳細はデバイスのヘルプファイルを参照してく
ださい。

OUTPUT IFデジタイザモジュールのフロントパネル上の INPUTコネクタに接続します。

このコネクタは周波数変換された IF信号をデジタル化するための出力端子で
す。

INPUT RFベクトル信号アナライザで測定するアナログ RF入力信号を接続します。
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表 3  NI 5600 RFダウンコンバータモジュールのフロントパネルの LED

LED 説明

POWER NI 5600 RFダウンコンバータモジュールの基本的なハードウェア電源状態を表示
します。この LEDの機能はデジタイザモジュールのフロントパネルにある
ACCESS LEDと同じです。

消灯—モジュールの準備が整っていない状態、もしくは PXIの電源レールで問
題が発生しています。

緑色—モジュールは正常に動作しており、電源が投入されています。

STATUS NI 5600 RFダウンコンバータモジュール PLLの状態を表示します。

消灯—モジュールが初期化されていないか、モジュールの PLLがロックの試行
中です。

緑色—モジュールは準備完了状態です。適用する PLLはロックされています。
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NI 5620 IFデジタイザモジュール
図 11に示すように、NI 5620 IFデジタイザモジュールのフロントパネルには 3つのコネク
タがあります。

図 11  NI 5620 IFデジタイザモジュールのフロントパネル
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50 Ω

+16 dBm MAX

INPUT
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NI 5620
64 MS/s Digitizer
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付録 B: トラブルシューティング
このセクションでは、RFベクトル信号アナライザのハードウェアの取り付けやソフトウェ
アのインストール、構成、および使用の際に発生する可能性がある問題について説明しま
す。

取り付け

PXIシャーシの電源を入れても NI 5600 RFダウンコンバータモジュールのフロ
ントパネルの POWER LEDが点灯しない
PXIシャーシの電源を投入しても POWER LEDが点灯しない場合は、PXIの電源レール、
ハードウェアモジュール、LEDのいずれかに問題がある可能性があります。この問題のト
ラブルシューティングは、以下の手順で行ってください。

1. PXIシャーシの電源を切ります。

2. RFベクトル信号アナライザハードウェアモジュール間のモジュールフロントパネル相
互接続をすべて外します。

3. RFベクトル信号アナライザハードウェアの両方のモジュールを取り外し、破損箇所が
ないか調べます。破損しているデバイスは再度取り付けないでください。

4. RFベクトル信号アナライザハードウェアの両方のモジュールを元の PXIスロットとは
別のスロットに取り付けます。お使いのデバイスの章に説明されている「PXIモジュー
ルを取り付ける」の手順を使用します。

5. PXIシャーシの電源を投入します。

6. それでも POWER LEDが点灯しないか、点灯しない状態が継続する場合は、NI技術サ
ポートまでお問い合わせいただくか、ウェブサイト ni.com/jp/supportを参照して
ください。

ハードウェアモジュールがMAXで表示されない
いずれかの RFベクトル信号アナライザハードウェアモジュールがMAXで表示されない場
合は、以下の手順に従ってください。

1. MAXの構成ペーンで、従来型 NI-DAQ（レガシー）デバイスフォルダを展開します。

2. <F5>キーを押して、取り付けられているデバイスのリストを更新します。

表 4  NI 5620 IFデジタイザモジュールのフロントパネルのコネクタ

コネクタ 使用

INPUT NI 5600 RFダウンコンバータモジュールのフロントパネルにあるOUTPUTコ
ネクタに接続します。

このコネクタは、デジタル化および測定するために NI 5600 RFダウンコン
バータから周波数変換された IF波形の入力端子です。

REF CLK IN NI 5600 RFダウンコンバータモジュールのフロントパネルにある下側の
10 MHz OUTコネクタに接続します。

このコネクタは NI 5600内部基準クロック信号の入力端子です。

PFI 1 外部信号源からデジタルトリガを受信します。トリガの詳細については、
『NI高速デジタイザヘルプ』を参照してください。
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3. リストを更新してもいずれのモジュールも表示されない場合は、システムの電源を切
り、RFベクトル信号アナライザハードウェアが正しく取り付けられていることを確認
し、システムを再起動します。それでもハードウェアが表示されない場合は、手順 4
に進んでください。

4. Windowsのコントロールパネルを開き、システム→ハードウェア→デバイスマネー
ジャを選択します。デバイスにより適切な手順に従ってセットアップを行います。

� PXIコントローラをお使いの場合、National Instrumentsの項目がシステムデバ
イスのリストに表示されていることを確認します。エラー状態がリストに表示され
ている場合は、ドライバソフトウェアの再インストールおよび RFベクトル信号ア
ナライザハードウェアモジュールの再取り付けを行います。

� MXI-3コントローラをお使いの場合、PCI-to-PCI Bridgeを右クリックし、ショー
トカットメニューからプロパティを選択して、ブリッジが有効になっていることを
確認します。

5. それでもMAXにいずれのモジュールも表示されない場合は、NI技術サポートまでお
問い合わせいただくか、ウェブサイト ni.com/jp/supportを参照してください。

RFダウンコンバータモジュールがセルフテストに合格しない
MAXのセルフテストでは、デバイスリソースを確認します。セルフテストで NI 5600が不
合格になった場合は、以下の手順に従ってください。

1. コンピュータを再起動します。

2. MAXを起動し、再度セルフテストを実行します。

3. お使いのデバイスの章の説明に従って、NI 5600モジュールを別のスロットに再度取り
付けます。

4. 再度セルフテストを実行します。

5. 上記の手順を行っても NI 5600 RFダウンコンバータモジュールがセルフテストに合格
しない場合は、NI技術サポートまでお問い合わせいただくか、ウェブサイト ni.com/

jp/supportを参照してください。

IFデジタイザモジュールがセルフテストに合格しない
MAXのセルフテストでは、デバイスリソースを確認します。セルフテストで IFデジタイザ
が不合格になった場合は、以下の手順に従ってください。

1. スタート→すべてのプログラム→ National Instruments→Measurement & 
Automationを選択するか、MAXのデスクトップアイコンをクリックしてMAXを起
動します。

2. 取り付けられているデバイスのリストを表示するには、構成ペーンでデバイスとインタ
フェースをダブルクリックします。

3. MAXで以下のいずれかのフォルダを展開します。

� NI 5620の場合は、従来型 NI-DAQ（レガシー）デバイスフォルダを展開します。
NI 5600 RFダウンコンバータおよび NI 5620 IFデジタイザモジュールを含む、取
り付けられているデバイスのリストが表示されます。

a. IFデジタイザモジュールの名前を右クリックし、プロパティを選択します。

b. 構成デバイスダイアログボックスが表示されます。テストリソースをクリック
します。

c. 構成デバイスダイアログボックスで、テストパネルを実行を選択します。テス
トパネルは IFデジタイザモジュールの機能テストを実行します。
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� NI 5142または NI 5622の場合は、NI-DAQmxデバイスフォルダを展開します。
NI 5600/5601 RFダウンコンバータモジュールおよび NI 5142/5622 IFデジタイザ
モジュールを含む、取り付けられているデバイスのリストが表示されます。

a. IFデジタイザモジュールの名前を右クリックし、セルフテストを選択します。

4. Startボタンをクリックしてテストパネルを実行します。

5. テストパネルが正常に終了したら、閉じるをクリックします。

6. 構成デバイスダイアログボックスでOKをクリックしてMAXに戻ります。

7. テストパネルが正常に終了しない場合は、NI技術サポートまでお問い合わせいただく
か、ウェブサイト ni.com/jp/supportを参照してください。

構成

RFベクトル信号アナライザが初期化されない
初期化されない場合は、モジュールの相互接続またはMAXに問題がある可能性がありま
す。RFベクトル信号アナライザが初期化されない場合は、以下の手順に従ってください。

1. お使いのデバイスの章に従って、RFベクトル信号アナライザハードウェアモジュール
のフロントパネルのケーブルを確実に再接続してください。

2. システムの電源を投入し、「7. NI 5660を構成およびプログラミングする」セクション
に説明されているMAX構成およびセルフテストの手順を実行します。

3. それでも問題が発生する場合は、NI技術サポートまでお問い合わせいただくか、ウェ
ブサイト ni.com/jp/supportを参照してください。

NI 5600 RFダウンコンバータの STATUS LEDが点灯しない
RFベクトル信号アナライザが外部基準信号源または PXIバックプレーンにロックされるよ
うにプログラミングしているにもかかわらず STATUS LEDが PLLのロック状態を表示しない
場合は、以下の項目を確認してください。

� ケーブルが外部信号源または PXI 10 MHz I/Oコネクタと FREQ REF INコネクタを接続
していることを確認します。

� 外部信号源からの信号が十分に大きい（通常、–10 dBmより大きい）ことを確認しま
す。

� 外部信号源からの信号が指定の周波数確度以内にあることを確認します。

RFベクトル信号アナライザが NI 5600 RFダウンコンバータモジュールの内部タイムベース
を使用するようにプログラミングされている場合は、以下の項目を確認してください。

� RFベクトル信号アナライザが周波数を正しく測定しないか、信号が供給されているの
にその信号を検出しない場合、1つまたは複数の内部発振器が位相ロックされていませ
ん。

� RFベクトル信号アナライザが周波数を正しく測定しているのに LEDが点灯しない場
合、ドライバソフトウェアのエラーまたは LEDの破損の可能性があります。

� それでも問題が発生する場合は、NI技術サポートまでお問い合わせいただくか、ウェ
ブサイト ni.com/jp/supportを参照してください。
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NI 5620/5142 IFデジタイザモジュールが RFダウンコンバータモジュールに位
相ロックしない

IFデジタイザモジュールがフロントパネルを通じて NI 5600 RFダウンコンバータモジュー
ルの内部基準に位相ロックされるようにプログラミングしているにもかかわらず問題が発生
する場合は、以下の項目を確認してください。

1. ケーブルに障害がないことを確認します。

2. NI 5600 10 MHz OUTフロントパネルコネクタから基準信号出力があることを確認しま
す。

3. これらの出力端子に信号がない場合は、NI技術サポートまでお問い合わせいただくか、
ウェブサイト ni.com/jp/supportを参照してください。

IFデジタイザモジュールが NI 5600 RFダウンコンバータモジュールの内部基準により駆動
されている PXIバックプレーンに位相ロックするようにプログラミングしているにもかかわ
らず問題が発生する場合は、以下の項目を確認してください。

� NI 5600が、PXIコントローラスロットのすぐ隣にある PXIシャーシのスロット 2に取
り付けられていることを確認します。

� お使いのデバイスの章に説明されているように、PXI 10 MHz I/Oコネクタが付属の
ケーブルで 10 MHz OUTコネクタの 1つに確実に接続されていることを確認します。

� 「ni5660 Configure Reference Clock」VIの drive backplane clockパラメータが
TRUEに設定されていることを確認します。

それでも問題やエラーが発生する場合は、NI技術サポートまでお問い合わせいただくか、
ウェブサイト ni.com/jp/supportを参照してください。

測定
RFベクトル信号アナライザを使用した測定についての詳細は、『NI PXI-5660 Help』を参照
してください。

RFベクトル信号アナライザの振幅の読み取り値が信号源と一致しない
RFベクトル信号アナライザが振幅の正しい読み取り値を表示しない場合は、以下のエラー
である可能性があります。

1. RFベクトル信号アナライザと信号源の不一致がデバイスの誤差限度以内であるか、以
下に従って確認します。

a. RFベクトル信号アナライザの絶対振幅確度を確認します。

b. 信号源の出力レベル確度を確認します。

2. ケーブルでの損失を確認します。（この影響が大きい場合があります。）たとえば、

RG58同軸ケーブルでは 2 GHzでの信号振幅の損失は 1フィートあたり 2.1 dBです。
高品質のケーブルを使用していない場合は、高周波信号を処理する時に損失が発生する
ことを考慮してください。

3. NIスペクトル計測ツールキットの振幅キャリブレーション機能を必ず使用してくださ
い。キャリブレーション機能を使用しないと、振幅オーバーのエラーが発生することが
あります。

4. それでもエラーが発生する場合は、NI技術サポートまでお問い合わせいただくか、
ウェブサイト ni.com/jp/supportを参照してください。



 

CVI, National Instruments、NI、ni.com、および LabVIEWは National Instruments Corporation （米国ナショナルインスツルメンツ社）の商標です。
National Instrumentsの商標の詳細については、ni.com/legalの「Terms of Use」セクションを参照してください。The mark LabWindows is used under a 
license from Microsoft Corporation. Windows is a registered trademark of Microsoft Corporation in the United States and other countries. 本文書中に
記載されたその他の製品名および企業名は、それぞれの企業の商標または商号です。National Instrumentsの製品 /技術を保護する特許については、ソフトウェ
アで参照できる特許情報 (ヘルプ→特許情報 )、メディアに含まれている patents.txtファイル、または「National Instruments Patent Notice」
（ni.com/patents）のうち、該当するリソースから参照してください。

© 2009 National Instruments Corporation. All rights reserved.

技術サポートおよびプロフェッショナルサービス

技術サポートおよびその他のサービスについては、ナショナルインスツルメンツのウェブサ
イト（ni.com/jp）の下記のセクションを参照してください。

� サポート—技術サポート（ni.com/jp/support）には以下のリソースがあります。

– セルフヘルプリソース—質問に対する回答やソリューションが必要な場合は、ナ
ショナルインスツルメンツのウェブサイト（ni.com/jp/support）でソフトウェア
ドライバとアップデート、検索可能な技術サポートデータベース、製品マニュアル、
トラブルシューティングウィザード、種類豊富なサンプルプログラム、チュートリア
ル、アプリケーションノート、計測器ドライバなどをご利用いただけます。ユーザ登
録されたお客様は、NIディスカッションフォーラム（ni.com/jp/dforum）にアク
セスすることもできます。 

– 標準サポート・保守プログラム（SSP）—NIのアプリケーションエンジニアによる
電話または Eメールでの個別サポート、サービスリソースセンターからのオンデ
マンドトレーニングモジュールのダウンロードが可能となるプログラムです。この
プログラムには製品ご購入時にご加入いただき、その後 1年ごとに契約更新して
サービスを継続することができます。

その他の技術サポートオプションについては、ni.com/jp/servicesをご覧いた
だくか、ni.com/contactからお問い合わせください。

� トレーニングと認定—自習形式のコースキットやインストラクタによる実践コースな
どのトレーニングおよび認定プログラムについては、ni.com/jp/trainingを参照し
てください。 

� システムインテグレーション—時間の制約がある場合や社内の技術リソースが不足し
ている場合、またはプロジェクトに関連する問題がある場合、ナショナルインスツルメ
ンツのアライアンスパートナーによるサービスをご利用いただけます。詳しくは、

NI営業所にお電話いただくか、ni.com/jp/allianceをご覧ください。

� 適合宣言（DoC）—適合宣言とは、適合宣言書によるさまざまな欧州閣僚理事会指令
への適合宣言です。この制度により、電磁両立性（EMC)に対するユーザ保護や製品の
安全性に関する情報が提供されます。ご使用の製品の適合宣言は、ni.com/

certification（英語）から入手できます。

� 校正証明書—ご使用の製品でキャリブレーションがサポートされている場合、
ni.com/calibrationからCalibration Certificate （英語）を取得できます。

NIのウェブサイト（ni.com/jp）を検索しても問題が解決しない場合は、最寄りの営業所
またはナショナルインスツルメンツ本社までお問い合わせください。各支社の電話番号は本
書の冒頭に記載されています。また、弊社ウェブサイトのWorldwide Officesセクション
（ni.com/niglobal（英語））から各支社のウェブサイトにアクセスすることもできます。
各支社のサイトでは、お問い合わせ先、サポート電話番号、電子メールアドレス、現行のイ
ベント等に関する最新情報を提供しています。
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